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Chapter 1

Introduction

1.1 Introduction

Dia is an application for creating technical diagrams. Its interface and features are loosely patterned after the Windows program
Visio. Features of Dia include multiple-page printing, export to many formats (EPS, SVG, CGM and PNG), and the ability to
use custom shapes created by the user as simple XML descriptions. Dia is useful for drawing UML diagrams, network maps,
and flowcharts.

This document describes version 0.97 of Dia.

hJ
User tnes
Dia ’

User continues
learning and using
Dia

User tells fnend
about Dha

Does it
fit the need?

That's too bad
Thanks for trying

Figure 1.1: Sample Flowchart Diagram

1.2 New in this version

* Transparency with colors

* Transformations, see Grouping Objecs - ToDo update for 0.97: property change working on selection, 0.98: transformations
of groups

* Object meta info editor, see Changing Properties

Embedded images ...
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Chapter 2

Quickstart

The Dia Quickstart is designed to help you get started creating diagrams with Dia without having to read a manual.

2.1 What Can You Do?

Dia is a diagramming application that can be used to make a large variety of diagrams. Dia is easy to learn and flexible enough to
allow power users to create highly customized diagrams. Below are two simple examples of diagrams that can quickly be created
using Dia.
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DpenBSD 2. 8
FTFE

2.2 Starting Dia

Lilnux
Dezlktop

Figure 2.1: Sample Network Diagram

DpenbBs D
Welh Server

You can start Dia by going into the Applications section on the Main Menu and clicking on the Dia icon. Or, you can type dia in

a console window or xterm.
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Create the tabbed interface by dia --integrated.

Figure 2.2: Dia tabbed diagramming

2.3 Creating a Canvas

All diagrams are drawn in their own canvas. When you first start Dia, a blank canvas is created automatically. At any time, you
can create a new canvas by selecting File — New Diagram The canvas may be customized in various ways, such as changing the
background color or grid lines. See The Canvas for more information on customizing the canvas.
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Dia startup showing blank canvas above and Toolbox.

Figure 2.3: Dia Startup

2.4 Making a Diagram

A diagram is made up of objects. Objects are shapes or lines that can be different colors and sizes. Objects can be simple line
drawings, text, or full-color pictures. Some objects allow text to be entered inside the shape.

Using Dia to create a diagram is easy. The Toolbox contains a palette of predefined objects, including simple shapes, lines, and
specialized objects. To add an object to the canvas, simply click on the desired object’s icon on the Toolbox and then click on the
desired point on the canvas. The object will appear on the canvas where you clicked. See Adding Objects for more information.

An object can be moved by clicking on the object and dragging the mouse. The object can be resized by clicking and dragging
one of the object’s green or red "handles". See Moving Objects and Resizing Objects for more information on moving and
resizing objects.

Objects can be connected using lines. Just drag each end of a line to any connection point (small blue "x") on an object. Once
objects are connected, they can be moved and the line stretches to keep them connected. See Connecting Objects With Lines for
more information on how to connect objects.

In the Toolbox, you can double-click on any object’s icon to view and edit the object’s default properties. This allows you to
customize various default properties of each object. For objects that include text, you can customize the text alignment and font
properties. For standard shapes, you can customize the transparency, the corner shape, and the aspect ratio. See Sources of
Default Properties for more information about changing default properties.

Dia includes a set of standard shape and line objects. See Objects for more information on working with the standard objects.
Dia includes a large number of predefined objects for various uses. These include flowcharts, UML diagrams, network diagrams,
and many others. See Special Object Categories for more information on the various objects available.

Many common tasks in Dia require selecting one or more objects. Dia includes a number of ways to select objects quickly. See
Selecting Objects for more information.

Dia can be customized in a number of ways. See Customization for more information on customization.
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Layers create multiple-images so they are one image. By doing this, a user can edit one layer without worrying about affecting
any of the other layers. See Managing Layers for more information on working with layers.

Dia is designed to make adding new user-defined shapes very easy. See Custom Shape Module for more information on creating
your own custom shapes.

2.5 Saving and Printing Your Diagram

Dia provides the normal save and print options, located on the File menu. Selecting the File — Page Setup allows you to set
the paper size, orientation, and print margins. This also allows you to choose whether to print the diagram to scale (entered in
percent) or to fit the diagram to a specific size (in centimeters).

Dia supports exporting to numerous formats for excellent web publishing. Some of them include:

* Computer Graphics Metafile (.cgm)
* Encapsulated Postscript (.eps)

* Portable Document Format (.pdf)

* Portable Network Graphics (.png)

* Scalable Vector Graphics (.svg)

See Loading and Saving Diagrams for more information.

Note
On some Windows systems, Dia diagrams do not print correctly. This problem can be worked around by exporting the diagram
-- for example to Portable Networks Graphics (.png) format -- and then printing the exported .png file.

2.6 Running Dia From the Command Line

Dia can be run from the command line. This allows certain Dia capabilities to be used in batch script files. See Dia Command
Line for more information on creating your own custom shapes.

2.7 Who Does Dia Appeal To?

Dia can be used by many people in a variety of industries.

* A systems engineer can create SADT diagrams for system analysis and design.
* A requirements engineer can compose e.g. RE-KAOS, RE-Jackson or RE-I* diagrams.

* A software developer can create UML diagrams of various types and extend them with the flexibility of a general purpose
diagram tool.

* A database designer can represent data relations with ER diagrams.

* A control engineer may draw Cybernetics diagrams.

* A computer programmer can create a flow chart to show the execution path of a program.
* A network administrator can create a diagram to model the company’s company network.
* An electrical engineer may use Dia to create a diagram to show how a circuit works.

* An mechanical engineer may design some Hydraulic or Pneumatic diagrams.



http://en.wikipedia.org/wiki/SADT
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http://en.wikipedia.org/wiki/Unified_Modeling_Language
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Chapter 3

The Canvas

3.1 Canvas Introduction

The Dia canvas is the window that contains the diagram. All of the user’s objects are placed and arranged on the canvas.

3.2 Grid Lines

Grid lines are similar to the lines on graph paper. They allow the user to easily align objects on the canvas. The grid lines can be
temporarily hidden for the current document by selecting View — Show Grid .

Grid line properties can be modified by selecting Diagram — Properties, which brings up the dialog shown in the figure below.

. Diagram Properties: E)

Grid|| colors

Dynamic grid

b ¥
Spacing
Visible spacing
Hex grid size
close || apply || o

Figure 3.1: Diagram / Properties / Grid

If the Dynamic grid box is checked, the grid adjusts automatically to keep the same visible spacing as the diagram view is zoomed
in or out. Also, when this box is checked, the other options on the dialog are disabled.

If the Dynamic grid box is unchecked, then the grid spacing remains the same in absolute terms. So when the view is zoomed
out, the grid appears smaller, and when the view is zoomed in, the grid appears larger.

The Spacing for the x and y coordinates is in centimeters and can be typed or entered using the increment / decrement buttons.
The visible spacing determines which grid lines are visible. A value of 1 indicates that all grid lines are visible, 2 indicates that
every second line is visible, and so on. Note that the snap-to-grid works the same whether or not grid lines are visible.
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The Hex grid checkbox allows you to create a grid of hexagons instead of squares. The Hex grid size is also in centimeters.

The snap-to-grid feature may be toggled on and off using the snap-to-grid button located below the canvas. When this is enabled,
objects are forced to align on a grid line.

zoonfiooos |~ [+ |l

Figure 3.2: Snap-To-Grid Toggle Button

3.3 Rulers

Rulers appear on the top and the left of the Dia canvas. They show, in centimeters, how large your canvas is. A centimeter on
the screen will not necessarily equal an actual centimeter. This will depend on your monitor’s dots-per-inch (DPI) setting and
your current zoom percentage. For example, if your monitor is set to 96 DPI and your zoom percentage is about 185%, then the
display ruler is at actual scale. Regardless of these settings, you can always see how big your objects and diagram are using the
on-screen ruler.

Note
When you print a diagram and select the option Scaling / Scale of 100.0%, the diagram will be printed to scale regardless of
the printer’'s DPI setting or the view zoom factor.

Each ruler has an arrow that moves along the ruler to show the exact coordinate of the mouse pointer. For example, if the user
moves the mouse up, the vertical ruler’s arrow will move up, indicating the change. These arrows are useful when an object
needs to line up exactly at a certain measurement point.

File Edit Diagram Wiew Objects  Sele

||:II I L I L I L @ I L I L I L I L |1
1]

k

Figure 3.3: Ruler With Arrows Circled in Red

Rulers can be temporarily hidden for the current document by choosing the menu item View — Show Rulers . Unlike grid lines,
rulers cannot be turned off by default for new documents.

3.4 Background Color

The background color option allows you to change the color of the canvas. By default, the color is white. However, the color
can be changed by selecting Diagram — Properties and then selecting the "Colors" tab. The first color option is Background.
You can change the color by selecting the drop-down list box and then using the standard color selection options. See Objects /
Colors for more information about selecting colors.
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(s tdprops-tesix

Grid || Colors

Background | #FFFFFF - |
Grid Lines | #DBESES &
Page Breaks | #000089 5 |

close || apply || ok |

Figure 3.4: Changing Background Color

Note
The gridlines will change their color automatically to stay visible if the background color is changed to black.

3.5 Zooming
Zooming allows the user to zoom in (make things bigger) or zoom out (make things smaller). Zooming in is useful when you are

trying to make your drawing very precise. Zooming out is useful when you want to view a larger portion of the diagram.

The canvas can be zoomed in to 2500% and out to 5%. Zooming can be done in several ways.

Figure 3.5: Toolbox Magnify

The Toolbox contains a Magnify tool. If you select the Magnify tool and then click anywhere on the canvas, the diagram is
zoomed in at that point by a factor of two (e.g., from 100% to 200%). Shift+Click reverses the process (i.e., zooms out by a
factor of two).

zonfsoe -]

400%
200%
100%:
0%
5%
12%:

Figure 3.6: Canvas Zoom
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Dia has a zoom control at the lower left corner of the canvas. This control allows you to enter in a zoom percentage or to select
from a series of fixed zoom percentages.

£ Diagram1.dia

File Edit Diagram BUEEN Ohjects  Select  Tools  Input Methods  Help
e | 0 010 - I R =
g ®, Zoom In Chrl++
K
7] S, Zoom Out Chrl+-
] 1600%:
4 Fullscreen Fi1 a00%:
i Antisliased 400%; alt+4
5] v Show Grid 283
- 200 alk+z
4 Snap To f&rid
a b 141
i v o5 To ©bject
_ nap 10 stk @, Mormal Size  Alk+1
4 v Show Bulers
7] 85
4 v Show Connection Points .7
1]
5 e Yiew &0 Alt+5
1 Clone Wigw 5.4
. 25
. &, Best Fit Chrl+E
N ®a Refresh

Figure 3.7: View Menu Zoom Options

The View menu has options for Zoom In (Ctrl++); Zoom Out (Ctrl+-); Zoom to a choice of fixed percentages; and Best Fit
(Ctrl+E).

Tip
The Ctrl+E (Zoom to Best Fit) is very useful for fitting the entire diagram in the window. It also provides a quick way to see if
there are any objects outside the current view area.
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3.6 Other View Menu Options

&, Zoom In Chrl++

=, Zoom Out Chrl+-
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Fullscreen Fi1
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¥ Snap To Objects
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v Show Conneckion Poinks
Mew Wiew
Clone Wiew

2, Eest Fit ChrH+E

®y Refresh

Figure 3.8: View Menu

In addition to the zoom options discussed above, the View menu provides a number of useful functions. These are discussed
below.

* Fullscreen (F11) toggles between the normal window view and full-screen view.

* AntiAliased toggles the antialiased feature on and off.

» Show Grid toggles the display of the grid on and off.

* Snap To Grid toggles the snap-to-grid property on and off.

* Snap To Objects toggles the snap-to-objects property on and off. When this is on, lines can be connected to the middle
connection point of an object by dragging the line end handle to any point inside the object. When this is off, the line’s
connection handle must be dragged to the middle connection point of the object being connected.

» Show Rulers toggles the ruler display on and off.
» Show Connection Points toggles the connection points display on and off.

* New View opens a new window that displays the same diagram. This can be useful if you want to see and work on different
sections of a diagram at the same time.

Tip

If you use New View or Clone View to open a second window on a diagram, changes you make in one window display
immediately in the other window. If you open the same diagram file in two different instances of the application (e.g., using
File / Open), you must save changes made in one session and re-load the diagram in the second session before they will be
visible to the second session. For this reason, using New View or Clone View is normally preferred.

* Clone View is the same as New View except that it copies the zoom and size of the first view instead of using the default values.

* Best Fit automatically zooms to the highest zoom value that will fit the entire diagram in the window.
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* Refresh redraws the diagram on the canvas. Normally this is not needed. Occasionally when making changes to a diagram,
however, the screen will not redraw correctly. For example, a portion of a deleted line might still display. If this happens,
Refresh correctly redraws the canvas.

3.7 Undo and Redo

Dia supports Undo and Redo on most operations. To undo an operation, press Ctrl+Z or select Edit — Undo from the diagram
menu bar. To redo an operation, press Ctrl+Shift+Z or select Edit — Redo from the diagram menu bar.
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Chapter 4

Objects and the Toolbox

A diagram in Dia consists of a set of objects. Objects are shapes that are either predefined or user-defined. The Toolbox allows
you to select the desired object and allows you to set default properties for objects.

4.1 Dia Toolbox Overview
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Figure 4.1: Dia Toolbox

When Dia is executed, two windows open: the canvas, which contains the diagram, and the Toolbox, which contains the object
palettes and other controls. The Toolbox is divided into three regions. The top region contains 14 buttons. The first three are
controls used to adjust the diagram. The next 11 are the icons for the built-in basic objects.

The middle portion of the Toolbox contains the selected Special Objects. This is used to select among the many built-in object
sheets supplied with Dia, such as UML, Flowchart, Network, etc.
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The bottom portion of the Toolbox contains special controls that set default properties for objects placed on the canvas. These
include foreground color, background color, and line width. There are also three controls that set the default properties for line
objects. These are beginning arrow style, ending arrow style, and line style.

4.1.1 Modify Control

Figure 4.2: Modify Control

The Modify control is the default setting when using Dia. This control allows you to select one or more objects on the canvas.
After an object is added to the diagram, the Modify control is automatically selected for you. This makes it easy to add an object
and then continue working without having to reselect the Modify control.

Tip

You can toggle between an object control and the Modify control using the Space key. For example, say you wish to add several
Box objects to the diagram. First, click on the Box icon and click on the canvas to add the Box. At this point, the Modify control
will be selected automatically. To reselect the Box control, press the Space key. Now you can click on the canvas again to add
a second Box object. Continue to press Space and then click to add as many Box objects as desired.

Tip
You can customize Dia to disable the automatic selection of the Modify control. See Customization / User Interface for more
information.

4.1.2 Textedit Control

Figure 4.3: Textedit Control

The Textedit control is new with Dia from version 0.97 - it indicates being in text edit mode. Together with an appropriate object
selection it is one way to start text modification.

An object supporting in-canvas text editing can be in two different selection modes. The normal selection is the same for all
objects, it allows to manipulate the objects position, grouping etc.. Some object can enter a second selection mode, which allows
to edit their text from the canvas.

Tip
There are multiple ways to enter text edit mode. You can press-and-hold the left mouse button, activate text editing by Enter or
F2 key or select the respective object after activating Textedit from the toolbox.
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4.1.3 Magnify Control

Figure 4.4: Magnify Control

The Magnify control is one method for zooming in or out. See The Canvas / Zooming for more information about zooming. The
Magnify control stays active until you press one of the other controls.

4.1.4 Scroll Control

Figure 4.5: Scroll Control

The Scroll control is used to move around the diagram. When this control is active, the mouse pointer changes to a hand. When
the Scroll control is active, you can scroll around the diagram by clicking anywhere on the canvas and dragging the mouse. The
diagram scrolls within the canvas window. The Scroll control stays active until you press one of the other controls.

4.1.5 Basic Objects

After the Modify, Zoom, and Scroll controls, the next 11 buttons allow you to place Dia’s basic objects on the canvas. See Basic
Objects Introduction for more information on Dia’s basic objects.
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4.1.6 Special Objects
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Figure 4.6: Special Objects

On the Toolbox, just below the basic object icons, is a drop-down listbox that allows you to select a sheet of special objects to
be included in the diagram. As you can see from the screenshot above, Dia provides a large number of special objects. To use a
special object, first select the desired sheet using this drop-down listbox. Then, just click on the desired object and click on the
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canvas to insert the object. See Special Object Categories for more information on the various types of special objects available.

4.1.7 Default Color, Line Width, and Line Style

ol |
|

>

Figure 4.7: Default Color, Line Width, and Line Style

Below the special objects palette are controls for setting the default foreground and background color, line width, and line style.
These controls all set default properties for new objects being added to the canvas. They do not affect the properties of existing
objects already on the palette. These settings stay in effect for all future Dia sessions, until they are changed.

The two squares on the left allow you to set the default foreground and background colors for all new objects being added
to the diagram. If you double-click on the upper square (i.e., the black one in the screenshot above), you can set the default
foreground color for all new objects. Double-clicking on the lower square (white in the screenshot) allows you to select the
default background color. See Objects / Colors for more information about selecting colors.

Tip

Figure 4.8: Restore Default Colors Button

To set the colors back to the default, click on the black and white box to the bottom left of the color selector.

Tip

Figure 4.9: Reverse Colors Button

To inverse the colors, click on the little arrow to the top right of the two boxes.

-
1
1
1

Figure 4.10: Default Line Width
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To the right of the two squares are five lines of increasing width. To select the desired default line width, simply click on it. A
dashed-rectangle indicates which width is currently selected.

— =

Figure 4.11: Arrow and Line Style

At the bottom of the Toolbox are three buttons. The left button allows you to select the default arrow shape for the beginning of
a line. In the screenshot this is defaulting to "no arrow". The right button allows you to select the default arrow shape for the
end of a line. Since only lines have arrows, these buttons only affect line objects and have no effect on other shapes. The middle
button allows you to select the default line style (solid, dashed, etc.).

Note

The line-width and line style settings affect all basic objects. For shapes, these settings determine the line properties of the
shape outlines. These settings also are used for some special objects (e.g., Flowchart objects). Other special objects (e.g.,
AADL objects) have fixed line widths and are not affected by these settings.

4.2 Using Objects

4.2.1 Adding Objects

Adding objects to the Dia canvas is done by clicking on the desired object’s icon button in the Toolbox and then clicking on the
canvas at the desired insertion point. The selected object will be inserted at that point.

Tip

You can quickly add multiple objects of the same type to the diagram using the Space key to toggle between the Modify control
and the desired object. For example, say you wish to add several Box objects to the diagram. First, click on the Box icon and
click on the canvas to add the Box. At this point, the Modify control will be selected automatically. To reselect the Box control,
press the Space key. Now you can click on the canvas again to add a second Box object. Continue to press Space and then
click to add as many Box objects as desired.

Tip

If you are using different colors or line styles for different objects, one trick to save time is to create a separate file of sample
objects with the desired properties on a separate diagram. Then copy and paste these objects onto your working diagram as
you need them.

4.2.2 Moving Objects

When an object is inserted into the canvas, the desired object will appear with small green boxes (known as handles) around the
border.

N

Figure 4.12: Object Handles

To move an object, click anywhere inside the object (or somewhere on a line other than a handle) and drag the mouse to the
desired location on the canvas. For line objects, you need to click on the line.
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Tip
When moving an object, be sure not to click on a handle. Otherwise, you will resize the object instead of moving it.

4.2.3 Resizing Objects

Handles are used to change the size of the object. To expand an object, just click a handle and drag it away from the center
of the object. To shrink an object, drag a handle toward its center. The object’s size will change as you drag the mouse. If an
object has a fixed aspect ratio, changing one dimension automatically changes the other. If an object has a free aspect ratio,
you can change one dimension (e.g., height) without affecting the other (e.g., width). Some objects have a property setting that
determines whether the aspect ratio is fixed or free.

4.2.4 Deleting Objects

To delete an object, click on the object to select it. The handles will display, which indicates that the object is selected. Then
press the Delete key or select Edit — Delete from the menu.

4.2.5 Connecting Objects With Lines

In many diagrams, shapes are connected to each other using one of the basic line objects. When a shape is not selected, a number
of connection points are displayed on its borders as small "x" figures. There is also a connection point in the middle of each
shape. Lines also have connection points where other lines can connect.

Lines have handles on each end that are used to connect them to other objects. These handles are green if the line is not connected
and red if it is connected. Lines also have orange handles that are used to shape the line. The figure below shows several lines
with green handles on the unconnected end and red handles on the connected end.

Figure 4.13: Line Handles

To connect two shapes with a line:

1. Select the desired line (Line, Zigzagline, etc.) by clicking on the Toolbox icon.
2. You can either click on the canvas to place the line on the diagram and then drag the "from" end of the line to the desired
connection point of the first object.

Or you can save a step by clicking directly on the desired connection point of the first object. In this case, the line will
display with the "from" end of the line already connected to the first object.

In either case, when the "from" end of the line is connected, it’s "from" handle will be red.

3. Click on green handle at the "to" end of the line and drag it to the desired connection point on the second object. When the
line is connected, the outline of the object being connected will turn red, as shown in the figure below.
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Figure 4.14: Line Connected

At this point, the two objects are connected. If you move either object, the line will stretch to keep them connected. If you
move the line, it will disconnect from both objects. If you do this by mistake, you can undo using Ctrl+Z or Edit — Undo.

At any time, you can disconnect or connect to a new point by clicking on the "from" or "to" handle and dragging it to a new
location on the diagram.

Tip
If you connect a line to a fixed point on a shape’s perimeter, it will stay connected to this point when the object is moved.

Figure 4.15: Fixed Connection Point

If you connect a line to the middle of an object, when you move the object the displayed connection point moves automatically,
so you don’t need to change the connection point.

r

Figure 4.16: Middle Connection Point

Note that, when a line is connected to the middle of an object, the line’s connection handle is still positioned on the perimeter
of the object. So to move the line’s connection point, drag on the line’s handle (as opposed to the middle of the object).
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Tip

If you connect a Line or Polyline object to the middle of a shape when you first place the line on the canvas, you need to be
careful when connecting the "to" end of the line. Be sure to click on the line’s handle and not on the surrounding area within the
shape. If you click on the surrounding area inside the shape, you will select the shape and not the line’s handle. If this happens,
click outside the shape to deselect it and then carefully click on the "x" in the middle of the object (not on the line’s arrow). The
handle will display, and you can drag it to the desired location. Note that the handle will display as red, because it is connected
to the middle. Also note that you need to drag it outside the shape before you can see the line.

See Basic Objects / Line for more information on the different lines available.

4.2.6 Entering Text

Text can be entered by selecting the object, entering text edit mode and then typing the text. The font, size, alignment, and other
formatting properties can be changed by double-clicking the object, when not in text edit mode.

Many Dia objects suport in-canvas editing of text. Dia versions before 0.97 had not explicit distinction between a selected object
and it’s text edit mode. As a result numerous workarounds were needed to support canvas and text editing with the same set of
keys, e.g. the Delete key was not deleting the character right to the cursor, but instead the whole object.

With Dia 0.97 and later there is a dedicated text edit mode. You can enter it by hitting Enter or F2 key while an appropriate object
is selected. To leave text editing just click outside of the editable area or hit the Escape key.

Copy Text
Cuk Text  Shift+Cerl+x
Paste Text  Shift+Chrl+y

Figure 4.17: Edit Menu Text Commands

Tip

While in text edit mode the normal Copy / Paste keys (Ctrl+C, Ctrl+V) work on the entire text. The Edit menu also contains the
commands Copy Text, Cut Text (Shift+Ctrl+X), and Paste Text (Shift+Ctrl+V) to copy, cut, and paste just the text contents of an
object. Note that when you paste text into an object, the text is formatted according to the Dia object properties, not the text
source.

Tip

You cannot select a section of text inside an object with the mouse (this moves the cursor). You can insert characters at the
current cursor position just by typing. You can delete the character to the left of the mouse using Backspace. The Del key
deletes the character right to the cursor. To delete all of the text in an object, use the Cut (Shift+Ctrl+X).

4.2.7 Aligning Objects

Dia provides several options to help arrange multiple objects without needing to move each object individually. These are
available on the Objects — Align menu choice shown below.
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Figure 4.18: Objects / Align Options

4.2.7.1 How To Align Objects

To align objects, first select the objects to align (see Selecting Objects ) and then execute one of the align commands, using either
the menu or the shortcut key. The order in which objects are selected does not matter.

4.2.7.2 Left, Center, and Right Align

The align left, right, and center are used to align objects arranged vertically on the canvas. The align left aligns the selected
objects to the left edge of the left-most object. Similarly, the align right aligns the selected objects to the right edge of the right-
most object. Align center aligns the center of each object to the mid-point between the extreme left and extreme right edge of all
selected objects. Examples of align left, center, and right are shown below.
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Figure 4.19: Before Left, Center, Right Align
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Figure 4.20: Align Left
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Figure 4.21: Align Center
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Figure 4.22: Align Right
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4.2.7.3 Top, Middle, and Bottom Align

The align top, middle, and bottom are used to align objects arranged horizontally on the canvas. The align top aligns the selected
objects to the top edge of the upper-most object. Similarly, the align bottom aligns the selected objects to the bottom edge of the
lowest object. Align middle aligns the middle of each object to the mid-point between the extreme top and extreme bottom edge
of all selected objects. Examples of align top, middle, and bottom are shown below.
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Figure 4.23: Before Top, Middle, Bottom Align
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Figure 4.24: Align Top
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Figure 4.25: Align Middle
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Figure 4.26: Align Bottom

4.2.7.4 Spread Out Horizontally and Vertically

The Align / Spread Out commands can be used to create uniform spacing for objects arranged either horizontally or vertically.
Examples of these commands are shown below.
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Figure 4.27: Before Spread Out Horizontally
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Figure 4.28: After Spread Out Horizontally
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Figure 4.30: After Spread Out Vertically

4.2.7.5 Align Adjacent or Stacked

The Align / Adjacent command is used to place objects next to each other with no horizontal space in between. The Align /
Stacked is used to place objects directly on top of each other, with no vertical space in between. Examples of these commands

are shown below.

File Edit Diagram Wiew Objects Select Tools Input Methods Help

.I.D.I.I.I.I.|5|I.I|I|I.llcll.I.I.I.|1$I|I|I.I.leI|V|I|I||2$I|I|I|
i
ghisis some test text. Y e Testtlass >
Test object
§ | _ Class
Brhis is 3 test

£ class.

] L
a1

Figure 4.31: Align / Adjacent
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Figure 4.32: Align / Stacked

4.2.7.6 Align Connected

The Align Connected command tries to align connected objects, so that the connecting lines are either horizontal or vertical
afterwards.

Figure 4.33: Before Align Connected
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Figure 4.34: After Align Connected

Note
The algorithm used to align connected objects is not fool proof, infact it is very simple. If the resulting alignment does not match
your expectations use Undo to revert it. A different selection of objects may producae a result more to your liking.

4.2.8 Grouping Objects

Grouping allows you to treat several objects as a single entity. A group enables you to fix the position of the member objects in
relation to each other and to change the properties of all member objects at one time. To create an object group, select two or
more objects and then select Objects — Group.

| Tl Tl |

Object 1 Object 2 Object 3
| 5 5 |
| - |
Object 1 Object 2 Object 3

Figure 4.35: Before and After Group Create

When the group is created or subsequently selected, a set of black handles displays around the outside of the group, as shown in
the figure above. At this point, you can move the entire group just like you would move a single object. Just click and drag on
any of the objects in the group.

You can also change the properties of all objects in a group by double-clicking or using the right-click context menu. See
Changing Properties for a Group of Objects for more information.
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4.3 Object Properties

The properties of an object control it’s appearance. Properties include text font and appearance; line width, style, and color;
transparency (i.e., draw background yes or no); foreground and background color; and any other settings that control the way an
object is displayed. Different types of objects have different sets of properties.

The specific properties of an object are determined in two different ways. The default settings in force at the time the object is
added to the canvas determine the object’s initial properties. Once objects are placed onto the diagram, their properties may be
set using the Properties dialog box for the object or for a group of objects.

4.3.1 Sources of Default Properties

An object’s default properties are set in two places within Dia. First, as discussed above in Default Color, Line Width, and Line
Style, default values for the foreground and background color; the line width; and the line style of all basic objects and some
special objects are determined by settings on the Toolbox. For basic lines, the default beginning and ending arrow styles are also
determined by the Toolbox settings.

The rest of an object’s default properties can be set using the Defaults: Properties dialog box for each object. This is opened by
double-clicking on the object’s icon on the Toolbox. Since the available properties for each type of object can be different, each
object’s default properties dialog is different. Below are examples of the default properties dialog for the basic Text and Box
objects.

General | Meta |

Text alignment [Left - l

Vertical text alignment l First Line - l

Font l sans - ” Mormal 3 l

Font size [D.SD cm %l

Draw background [ Mo l
[ Close ] [ Apply l [ oK ]

Figure 4.36: Default Text Properties

General Meta|

Draw background [ fes l

Corner radius [D.DD H

Aspect ratio [Free o l
close || apply || ok |

Figure 4.37: Default Box Properties
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For objects that include text, the dialog will normally include the text alignment, the font name, the font modifier (normal, bold,
etc.), and the font size (in centimeters, not points). This makes it possible to set defaults for text display for any object that can
contain text.

4.3.2 Changing Object Properties

Once objects are placed onto the diagram, their properties can be changed either individually or as a member of a group.

4.3.2.1 Changing Properties for One Object

To change the properties of an individual object, either double-click on the object or select the object, right-click to display the
context menu, and select the Properties option. In either case, the Properties dialog for the selected object will display, allowing
you to change any of the object’s properties.

Note
If multiple objects are selected, you can still change the properties of one of the selected objects by double-clicking that object.
This will only change the properties of the one object you double-clicked.

4.3.2.2 Changing Properties for a Group of Objects

You can change the properties of a group of objects at one time by selecting two or more objects and then selecting Objects
— Group to create a group. Once the group is created, you can set properties for all objects in the group. To do this, either
double-click on the group or right-click to display the context menu and select the Properties option. The Properties: Group
dialog will display. Only properties that pertain to all of the selected objects will display in the dialog. If your group contains
only objects of one type, then all of the properties for that object type will display.

For example, if a group contains all basic Line objects, all of the Line properties will display in the Properties: Group dialog. If a
group contains a basic Line and a basic Box, the Properties: Group dialog will only show Line width, Line color, and Line style,
since these are the properties these objects have in common.

Changing properties for a group is a powerful feature of Dia. For example, say you have a large diagram and you need to change
the line style of all the basic Line objects everywhere in the diagram. You can accomplish this easily with the following steps.

1. Select one basic Line object.

2. Use Select — Same Type to select all of the basic Line objects on the diagram.
3. Use Objects — Group to create a group for the selected objects.

4. Double-click on the group and make your property changes.

5. Use Objects — Ungroup to remove the group.

With this technique, you can quickly change the properties of many objects. This also works with selections containing multiple
object types, as long as all of the selected objects have the properties you want to change.

4.4 Colors

All objects in Dia have color attributes. Lines have line color. Shapes have line color and fill color. Text and other objects that
contain text have text color. In addition, the Diagram — Properties allows you to set colors for Background, Grid Lines, and
Page Breaks. Finally, the Toolbox allows you to set default foreground and background colors for new objects.

In most cases, there are two methods for selecting a color. First, you can select a color from a list of colors provided in the
drop-down listbox by each color property.
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General | Metg |

Line color #FFFFFF

Line style

Line ¢ aps #000099
#DBESES

| Arrows < TSI
#00FSFF

Start arro #FFFFOO

Figure 4.38: Color Listbox

=
o
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L]

The list contains five primary colors (black, white, red, green, and blue) plus custom colors that have been previously used. You
can just select a color from the list or select "More colors..." to display the Select color box. The Select color box allows you to

select any color. It is explained in the next section.

4.4.1 Select Color Box

5

Hue:

Value:

saturation:

1120
EEE
o3 |3

Bed:
Green:

Blue:

144

238 |5
144 |2

Opacity:

e 4

Color name: [#QUEEQD

|7

Ealette:

. —|il HHEEE W

Figure 4.39: Select Color Box

The Colors selector box contains 7 zones:

Cancel QK '

1. The colors wheel allows you to select a color using the mouse. Select the color you want from the outer ring. A white or
black line shows the current position on the ring. Select the darkness or lightness you want using the inner triangle. A white
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or black circle shows the current position in the triangle. You can click or drag on either surface. The currently-selected
color displays in the right side of the rectangle just below the circle.

Below the color wheel there are two rectangles. The left one displays the current color of the object, the right one the new
color (i.e., the one you currently have chosen using the colors wheel). Pressing the OK button will set the object to the new
color.

Just to the right of these rectangles, there is a pipette button. When you click this button, the mouse pointer changes to
a pipette. When the pipette is active, you can click on the canvas or any open application window (Like The Gimp), and
select any color!

Note
On Windows, you can only select from colors on the Dia canvas.

In the lower right there is a predefined color palette. Click on any of these to choose the color.
To control the transparency of the color you can use the slider in the middle right.

In the upper center there are settings for Hue, Saturation, and Value (HSV). You can select a color by typing a numeric
value or by using the increment / decrement controls. Note that when you enter a value here, the color wheel selection
changes to reflect the new color.

To the right, there are settings for Red, Green, and Blue. These work the same as the HSV controls.

In the middle of the box is a place to enter a Color name. This supports standard color names or HTML-style hexadecimal
color values. (See HTML4.01 colors on http://www.w3.org), and hexadecimal values (0-9A-F) on 3 or 6 octets.

4.5 Diagram Tree

The Diagram Tree provides an alternative method of working with a diagram. This window displays a list of all objects in the
diagram in a scrolling list box. By right-clicking on an object, you can perform a number of operations.

4.51

Opening the Diagram Tree

The Diagram Tree is shown by selecting File — Diagram Tree from the Toolbox menu bar or by pressing F§ when the Toolbox
is in focus.

4.5.2 Working With the Diagram Tree

Some actions on the Diagram Tree affect the diagram itself. By selecting objects in the tree, you can modify multiple of them at
once. You can sort the objects in the tree by type or name. click on the respective table header. If you right-click on the Diagram
Tree list, a context menu displays with three options.



http://www.w3.org/TR/html401/types.html#h-6.5
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Diagram lree

MName Type

* rendertest.dia
= std-propstest.dia
= Background
Test for std-props T
The following objects are supposed to haw... T

stal Diagram: /mnt/Homefwith-git/diafsamples/std-props-test.dia
stg Layer: Background

Type: Standard - Text

Stalposition: 2,3

Stal0 Children

Standard - Line

Standard - Line -line styles - arrows
Text

Standard - Text - font styles - alignment

Standard - PolylLine

|5 ==/

(<]

Figure 4.40: Diagram Tree

These options are explained below.

* Select will transfer the current the selection in the tree to the diagram.

* Locate will bring the selected object(s) into view on the canvas. This can be useful if you are trying to find an object in a large
diagram.

* Properties will display the properties dialog for the selected object(s). See Object Properties for more information.




Dia 36/78

Chapter 5

Basic Objects

5.1 Basic Objects Introduction

Figure 5.1: Basic Objects

Dia has a dozen basic objects: Text, Box, Ellipse, Polygon, Beziergon, Line, Arc, Zigzagline, Polyline, Bezierline, Image and
Outline.

5.1.1 Text

Dia supports the use of text as its own type of object. Text can be placed on the canvas by clicking on the text button on the
toolbox. For tips on editing text, see Entering Text in the Using Objects chapter.

Note
Text in Dia can use almost any font available in the system. But if you plan to exchange diagrams with people using a different
plattform, it would be smart to restrict yourself to a common subset.

The text object, and several other 